INFORMATION AND COMMUNICATION TECHNOLOGY
STANDARD 9
Theory- First Terminal Examination

Section 1(Choose the correct answer)

1.Which among the following is an open source image manipulation programme?
a. photo shop
b. gimp
c. ktoon
d. eye of gnome
Answer : b. gimp
2.Which of the following tools in GIMP software can be used to merge various colours in a
selected layer ?
a.
b.
c.
d.
Answer : b.

3.The following are some tools in GIMP tool box. Which one among these is not a
Transform tool?
a.

b.
c.
d.
Answer: a.
4.Which among the following is a open source image manipulation programme?
a. GNU
b. GNOME
c. GIMP
d. Gcolor2
Answer: c.GIMP
5.Which among the following is the suitable extension (file format) for an image file?
a.
b.
c.
d.

png
html
ods
txt

Answer: a. png
6.Given below is a tool in the toolbox of GIMP software. It is used to..........

a.
b.

select pictures
add pictures

c. merge various colours
d. take copy of an image
Answer : c. merge various colours
7. Given below is a tool in the toolbox of GIMP software. Name it.

a. Smudge tool
b. Scale tool
c. Move tool
d. Pencil tool
Answer : c. Move tool
8.Given below is a tool in the toolbox of GIMP software. Name it.

a.

Scale tool

b. transform tool
c. flip tool
d. rotate tool
Answer : c. flip tool

9.Given below is a tool in the toolbox of GIMP software. It is used to............................

a. Add text
b. zoom
c. select colour
d. draw pictures
Answer - a. Add text
10. Sabu and Jaseela were preparing two different collages in Gimp. Both of them had included
two pictures in their collages. When Sabu tried to move one of the pictures, both the pictures
moved. But Jaseela didn't face such a problem. What might be the reason?
a. Jaseela included the pictures in different layers
b. Jaseela included the pictures in same layer
c. Jaseela didn't included layers.
d. None of the above
Answer : a. Jaseela included the pictures in different layers

11. Anu wants to paint the background of her poster prepared in GIMP by merging two colours.
Which tool can be used for that?
a.

Transform tool

b. Blend tool
c. Brush tool
d. Selection tool
Answer : b. Blend tool
12. Can you help Hakkem by selecting the tool to reduce the size of a butterfly he added in
Gimp?
a) scale tool
b)move tool
c)brush tool
d)flip tool
Answer: a. scale tool
14.Which of the following statements is true?
A) An image can be opened in GIMP as File → Open
B) An image can be opened in GIMP by right clicking on the image file , Open
with → Gimp Image Editor
a .A only is true
b. A and B are true
c. B only is true
d. A and B are false
Answer : c. A and B are true
15. What is the use of the following tools in GIMP software?

a. to paint the canvas
b. to increase the size of the canvas
c. to colour the canvas with Gradient
d. to create a new layer
Answer : c. to colour the canvas with Gradient

16..SUM function in Open Office Spreadsheet is used
A. to find out total
B. to sort the data
C. to find out power
D. to find out average
Answer : A. to find out total
17. Which of the following options in Open Office Spreadsheet helps you to change the size of
your document as per the size of paper in the printer?
A. Paper format
D. Styles and formatting
Answer : A. Paper format

18.

B. Paragraph settings

C. Page preview

Which of the following techniques in Open Office Spreadsheet is used to fix a particular

row and column permanently so that we can see them even while scrolling ?
a)
b)
c)
d)

Auto filter
Cell Freezing
Function wizard
Hyper link

Ans:b) Cell Freezing
19.Which of the following techniques in Open Office Word processor is most suitable to make a
project report attractive easily?
a)
b)
c)
d)

Copy and Paste
Styles and Formatting
Index and Tables
Bullets and Numbering

Ans : b)Styles and Formatting
20.Which of the following techniques in Open Office Word processor is used to change the lay
out of a page from vertical into horizontal?
Options
a) Orientation
b) Header
c) Style
d) Background

Answer
a) Orientation
21.As part of Total Physical fitness Programme, the details of health of students have been
consolidated in OpenOffice Spreadsheet. Which of the following techniques is used to find out
the number of students having a specific weight?
(a) SUM
(b)AVERAGE
(c)COUNTIF
(d) POWER
Answer : (c)COUNTIF
22).Which of the following functions in OpenOffice Spreadsheet can be used to find out the
power of 2?
(a)
= POWER(2,5)
(b)
=POWER(5,2)
(c)
=ROUND(2,5)
(d)
=ROUND(5,2)
Answer : = POWER(2,5)
23). There is a table in Spreadsheet containing the details of health of students. To get the list
of students having height greater than 160 cm, which of the following techniques can be used ?
a. freeze
b. window
c. hyper link
d. filter
answer: a) filter
24). There is a table in Spreadsheet containing the BMI of students. Which of the following
techniques will help you to get a separate list of BMI of boys in 9th standard?
(a) filter
(b) freeze
(c) SUM
(d) AVERAGE
Ans:

(a) filter

25). What is the out put of the Function POWER (2,3) in OpenOffice Spreadsheet
a.
23
b.
8
c.
2.3
d.
6

Answer- b. 8
26).Which of the following is the extension of a file prepared in Open office Presentation?
a)
b)
c)
d)

.odp
.odt
.xcf
.ods

Ans_ a) .odp
27). In a table prepared in OpenOffice Spreadsheet , Tessy found that a particular data is
repeated in different cells . She wants to find out how many times it has been repeated. Which of
the following techniques will help her to do that?
A.SUM
B.COUNTIF
C.ROUND
D.POWER
ANSWER: B.COUNTIF
28).Which of the following Application software is most suitable to prepare a questionnaire for
data collection?
a) Gimp Image Editor
b) IDLE
c) Open Office Word Processor
d) Open Office Draw
Answer: c) Open Office Word Processor
29). Which of the following is known as Cell Freezing in OpenOffice spreadsheet?
a) Freeze the data in a cell
b) fix a particular row and column permanently in a worksheet
c) Freeze a picture
d) Delete the data in a particular cell
Answer b) fix a particular row and column permanently in a worksheet
30). One of the following can't be the normal extension of a document prepared using one of the
office package software . Find it out.
A. .odt
Answer: C. .png

B. .ods

C. .png

D. .odp

31). Read the following statements A and B and choose the most suitable one from the
options. .
A) Slider is a tool used to enlarge a shape based on the distance from a given point in
Geogebra
B) Slider is used to control length , number of sides and size of angles in Geogebra
a) A is true
b) A and B are true
c) B is true
d) A and B are not true
Answer : c) B is true
32).The technique used in GeoGebra to make a slider works automatically is
a) Trace on
b) Animation
c) Dilation
d) Exporting
Answer : b) Animation
33).Which of the following software can be used to draw mathematical shapes ?
a) KStars
b) Sunclock
c) GeoGebra
d) GPeriodic
Answer : c) GeoGebra
34).Which of the following tools in Geogebra is used to find out angle ABC.

a)

b)

c)

d)

Answer : c)
35).Which of the following tools is used to draw a hexagon in Geogebra ?
a) polygon
b) regular polygon
c) distance or length
d) segment between two points
Answer : b) regular polygon
36). Seema wants to type in the name of the shape she has drawn in Geogebra. Which of the
following tools can she use?
a) Move Tool
b) New Point
c) Insert Text
d) Insert Image
Answer : c) Insert Text
37).Which of the following tools is used to draw a Hexagon in Geogebra.
a)
b)
c)
d)
Answer : b)

38).Given below is a Pentagon drawn in Geogebra. Which of the following tool can be used to
draw its diagonals ?

a) Polygon
b) Angle
c) Slider
d) Segment between Two Points
Answer : d) Segment between Two Points
39).Which of the following option is used to hide temporarily the name of the vertices of a
triangle drawn in Geogebra
a) Click the left mouse button on the vertices and click show label.
b) Click the right mouse button on the vertices and click show label.
c) Click the left mouse button on the vertices and click show object.
d) Click the right mouse button on the vertices and click show object.
Answer : b) Click the right mouse button on the vertices and click show label.
40).Which of the following is the tool used to measure the length of a diagonal of a rectangle
drawn in Geogebra.

a)
b)
c)

d)

Answer : c)

41). Anitha wants to prove the idea that All the points equidistant from a central point would
form a circle . She has drawn a picture as given below. When she moves the slider the point B'
moves round the point A. But the path traversed by that point is not visible. Which of the
following step would she take?

a) Right click on slider and click the option Animation on
b) Right click on point B'and click the option Trace on
c) Right click on the point t A and click the option Trace on
d)Right click on point B'and click the option Animation on
Answer : b) Right click on point B'and click the option Trace on
42). Select the step to find out the perimeter of a pentagon created using Polygon tool in
Geogebra.
a) Select Area tool and click inside the Pentagon
b) Select Area tool and click on one side of the Pentagon
c) Select Distance or Length tool and click inside the Pentagon
d)Select Distance or Length tool and click on one side of the Pentagon
Answer : c) Select Distance or Length tool and click inside the Pentagon
43). Which shape can be drawn using the given below tool?

a)Rectangle

b) Equilateral triangle
c) Right angle triangle
d) isosceles trapezium
Answer : b) Equilateral triangle

44).Which of the following is not a mathematical software?
a) GeoGebra
b) Kig
c) Dr.Geo
d) GPeriodic
Answer : d) Gperiodic
45).Raju is drawing a polygon using the tool Polygon. But he can't complete it as the number
of sides increased with each click and drag of mouse. How can he complete it?
a) Right click
b) Double click
c) Click on the starting point.
d) Press The ESC key in keyboard.
Answer : c) Click on the starting point.
46).The slider window to create a regular polygon is shown in the picture. What is the maximum
number of sides of the polygon created when the slider is activated.

a) 3 sides
b) 4 sides
c) 5 sides
d) 6 sides
Answer : d) 6 sides
47).Which is the step to display the html code of a web page opened in Mozilla Fire Fox?
A. View → html code

B. View→ Source code
C. View → Source code
D. Right click menu →View page source
Answer : d)

Right click menu →View page source

48).Which software can be used to open a web page
A. Evins pdf viewer
B.VLC Media Player
C. Mozilla Firefox
D. gedit Text Editor
Ans_ C. Mozilla Firefox
49).

Identify the html tag to give heading to a web page.

A. <h>
B. <br>
C. <br/>
D. </h>
Ans: A. <h>
50).Identify the html tag used to italicise the letters in a web page.
A. <b>
B. <i>
C. <a>
D. <u>
Answer

B. <i>

51)What is the purpose of the html tag <marquee>?
A. To insert picture in a web page
B. To add title
C. To move letters and pictures
D. To link with another web page
Answer : C. To move letters and pictures
52).Which are the tags indispensable in a web page?
A.
<head> …........</head>
B.

<title>.............</title>

C.

<html>.............</html>

D.

<body>............</body>

Ans

C.

<html>.............</html>

53).Identify the html tag to give blue as background colour?
A. <body bgcolour=”blue”>
B. <background color=”blue”>
C. <body bgcolor=”blue”>
D. <body bg color=”blue”>
Ans :C. <body bgcolor=”blue”>

54).Which html tag is used to scroll the title of a web page from left to right ?
A. <marquee>
B. <marquee direction=”up”>
C. <marquee direction=”right”>
D. <marquee direction=”down”>
Ans : A. <marquee>
55). These are the source code of two lines in a web page.
<h1> Welcome all of You <h1>
<h2> Good Morning> <h2>
Which line should be displayed with increased size in a browser?
A. Welcome all of You.
B. Good Morning.
C. Both have same size.
D. Both would be with 1,2 pixels size.
Ans: A. Welcome all of You
56).Which among the following is a web browser software?
A. Internet Explorer
B. Mozilla Firefox
C. Google Chrome
D. All the above
Ans: D. All the above
57).Ummukkulsu wants to give her class name STD 9 B as the title of her web page. Which of the
following is the tag to be selected for that?
A. <title> STD 9B</title>
B. <title> </title> STD 9B
C. </title> STD 9B</title>
D. </title> STD9B <title>

Ans : A.<title> STD 9B</title>
58).What is the use of <br/> tag in web page ?
A. To create new page
B. To create new paragraph
C. To create new table
D. To create new line
Ans : D. To create new line
59).Which is the essential tag that must be included in a web page?
A. <head> ...........</head>
B. <title>.............</title>
C. <html>.............</html>
D. <body>............</body>
Ans: C. <html>.............</html>
60).Who is the founder of Free Software Foundation?
a) Michael Hart
b) Richard Stallman
c) Linus Torvalds
d) Gimmy Wales

Answer : b) Richard Stallman
61).Read the following and find out which of the given below statements is true in the case of the
work done by an Operating system?
A. File management B. memory management
a) A is true
b) B is true
c) A and B are true
d) A and B are false
Answer : c)A and B are true
62).Who is the founder of Free Software Foundation?
A. Linus Torvalds
B .Alexander Pushkin
C.Richard Stallman

D. Tim Burners Lee
Answer : C. Richard Stallman
63).Which among the following is an Open source Operating System ?
a)GIMP
b) MAC OS X
c)WINDOWS
d)GNU/LINUX
Ans_ d) GNU/LINUX
64).Which among the following is an Operating System which allows us to copy and
redistribute it with out any restrictions?
a) Ubuntu GNU/Linux
b) Windows 7
c) Symbian OS
d) Mac OS X
Ans_ a) Ubuntu GNU/Linux
65). What will happen when you press the key Print Screen in keyboard?
a) The files on Desktop get printed.
b) An image of Desktop is created.
c) A file is created.
d) The colour of Desktop gets changed.
Answer b) An image of Desktop is created.
66). Which of the following is not useful to take Screen shots?
a) Print screen
b) Add to Panel
c) KSnapshot
d. Gnome-screenshot
Answer b) Add to panel
67). Which among the following is an open source software?
a) Microsoft Windows
b) IBM AIX
c) GNU/ Linux Ubuntu
d) Apple Mac OS

Answer: c) GNU/ Linux Ubuntu
68).Which among the following is an open source Operating system?
a)
Mac OS X
b)

Windows Vista

c)

Ubuntu GNU/Linux

d)

DOS

Answer : c) Ubuntu GNU/Linux
69).Which among the following is the use of the key Print Screen in the key board?
a)

To print the keyboard lay out.

b)

To take Screen shot

c)

To print a page.

d)

To install a Printer

Answer : b) To take Screen shot
70).Which among the following is not an Operating System?
a. Microsoft Windows
b. Ubuntu GNu/Linux
c. Mozilla Fire fox
d. Mac os x
Answer - c. Mozilla Fire fox

SECTION 2 (Select the two correct answers from the four options)
1mark each
71).Find out two formats from the following list in which the collage prepared in GIMP
can be saved.
a. png
b. odp
c. xcf
d. mp3

Answer: a. png
c. xcf
72).Which of the following statements are true?
a. An image prepared in GIMP can't be edited later.
b. An image prepared in GIMP can be edited later.
c. An image prepared in GIMP can't be saved in various formats..
d. An image prepared in GIMP can be saved in various formats.
Answer:

b. An image prepared in GIMP can be edited later.
d. An image prepared in GIMP can be saved in various formats.

73).Two of the given below statements are true. Find them out.
a. Rotate tool is used to tilt an image.
b. Rotate Tool is used to turn a picture either towards left or right.
c. Scale Tool is used to resize an image
d. Smudge Tool is used to change the size and shape of an image.
Ans:

a. Rotate tool is used to tilt an image.
c. Scale Tool is used to resize an image

74).Which of the following actions can be done using Transform Tools in GIMP?
a. Crop an image
b. Resize an image
c. Include layers
d. Turn a picture over either towards left or right.
Ans :

b. Resize an image
d. Turn a picture over either towards left or right.

75). Which of the following are the extension of image files. (Find out any two)
a. gif
b. mp3
c. tif
d. mp4

Answer: a. gif

c. tif

76).Ameer is preparing a collage in GIMP. Which of the following tools can be used to transform
a picture inserted in it?
a. Flip tool
b.

Zoom tool

c.

Clone tool

d.

Rotate tool

Answer: a. Flip tool
d. Rotate tool
77). What are the formats into which a collage prepared in GIMP can be exported?
a, jpg
b, png
c, odt
d, ods
Answer : a, jpg
b, png
78).What are the uses of Functions in Open office Calc? (find out two )
a. used to fix a particular row and column permanently
b. used to find out squares and square roots of numbers.
c. used to record videos
d. used to fix the number of decimal places in a decimal number.
Answer-

b. used to find out squares and square roots of numbers.
d. .used to fix the number of decimal places in a decimal number.

79). Which among the following statements are true related to the Functions in OpenOffice
Spreadsheet. (find out two statements)
a. They are short programmes used to arrange data in a table and print it.
b. They are short programmes used in OpenOffice Spreadsheet to do various operations
quickly.
c. COUNTIF is the function used to create separate list of boys from a table containing
both boys and girls.
d. COUNTIF is the function used to find out the number of boys from a range containing
both boys and girls.
Answer- b. They are short programmes used in OpenOffice Spreadsheet to do various operations
quickly.
d. COUNTIF is the function used to find out the number of boys from a range

containing both boys and girls.
80). Majeed ,the poet e-mailed his poems to a magazine in pdf format . Why did Majeed use
pdf format ? ( (find out two statements)
a) Pdf files can be opened in any Operating System
b) Pdf files will be displayed in big letters in any Operating System
c) It is not easy to make changes in a pdf file.
d) Pdf files can be converted into any other file format.
Answer
a) Pdf files can be opened in any Operating System
c) It is not easy to make changes in a pdf file.
81).The members of Eco club have prepared a letter in Hindi related to the protection of
Environment to be e-mailed to the Central Minister. But teacher suggested to export it as pdf file
before sending . Why did she suggest it?
a) Even if the software used to prepare the letter is not in the receiver's system, he can
open the letter in PDF .
b) Only PDF files can be e-mailed.
c) Hindi will be readable only if it is a PDF file.
d) Even if the font used to prepare the letter is not in the receiver's system, he can read
the letter in PDF .

Answers :

a) Even if the software used to prepare the letter is not in the receiver's system, he
can open the letter in PDF .
d) Even if the font used to prepare the letter is not in the receiver's system, he can
read the letter in PDF .

82). Which of the following are included in Open Office package?
a.
b.
c.
d.

Calc
GIMP
Mozilla
Impress
Answer :
a) Calc
d) Impress

83).What are the steps to include a video into a slide in Open Office Presentation?
i. Insert - Movie and Sound.
ii. Format - Movie and Sound.
iii. Select the video file → open
iv. Include the web address.
Answer: i. Insert - Movie and Sound.
iii. Select the video file → open
84).Which among the following constructions in Geogebra cannot be controlled by sliders?
a) Segment with given length
b) Circle with centre through point
c) Angle with given size
d) Circle through three points
Answer :
a) Circle with centre through point
b) Circle through three points
85).Johnny wants to construct an Angle slider with angle size that varies from 0° to 180°
in Geogebra. What are the steps to construct that slider?
a)Select Angle tool .
b) Select Slider tool .
c) Fix the angle values 0° as minimum and 180° as maximum.
d) Fix increment as 0 .
ANSWER : b) Select Slider tool .
c) Fix the angle values -0° as minimum and 180° as maximum.
86).What are the properties of an object that can be changed in the object property window of
Geogebra?
a) It is possible to insert text.
b) It is possible to change colour.
c) It is possible to insert images.
d) It is possible to change style.
ANSWER -

b)It is possible to change colour.
d) It is possible to change style.

87).From the given statements find out the right ones.
a)Geogebra is an application software used to create interactive geometrical constructions.
b) Geogebra files can be exported to html format.
c) It is possible to construct pictures in Geogebra using html tags.
d) It is possible to edit sound files using Geogebra.

ANSWER a)Geogebra is an application software used to create interactive geometrical constructions.
b) Geogebra files can be exported into html format.

88).From the given statements point out the ones that show the difference between number sliders
and angle sliders in Geogebra.

a) Animation can be applied only to a slider that controls a number.
b)Number slider can be used to control the angle size of a regular polygon.
c) For an angle slider, the radio button Angle from the slider window is be selected
instead of number.
d) Number sliders are named as a,b,c and angle sliders as α,β,γ
Answer: c) For an angle slider, the radio button Angle from the slider window is be selected.
d) Number sliders are named as a,b,c and angle sliders as α,β,γ
89). Given below is a slider created by Saleena in Geogebra. Which are the activities that can be
done using this slider?

a. It is possible to change the number of sides of a polygon.
b. It is possible to measure interior angles.
c. It is possible to measure the area of a construction.
d. It is possible to change the length of a line .
Answer
a. It is possible to change the number of sides of a polygon.
d. It is possible to change the length of a line .
90). Pick out any two softwares used to construct geometrical figures including lines and circles .
a. Marble
b. GeoGebra
c. Sunclock
d. Dr. Geo

Answer : b) GeoGebra
d) Dr. Geo
91).Mini wants to change the name of vertex of a regular hexagon drawn in Geogeba. Which are
the right steps to do it?
a) Click the left mouse button on the vertex and click rename option
b) Click the right mouse button on the vertex and click rename option
c) Click Show Object option
d) Click Object Properties option
Answer
b) Click the right mouse button over the vertex and click rename option
d) Click Object Properties option.
92). Which among the following tags are to be used to make the words 'My Country' red and move
from left to right?
a. <body bgcolor=”red”>
b. <font color="red”>.
c. <marquee direction=right>
d. <marquee direction=left>
Answer
b.<font color="red”>
c.<marquee direction=right>
93).Which among the following are the ways to open a file with the extension .html in gedit text
editor?

a) gedit → file → New
b) Right click on the file → open with → gedit
c) gedit → file → Open
d) gedit → file → Edit
Ans_ b) Right click on the file → open with → gedit
c) gedit → file → Open
94).Which among the following are true in the case of web pages?
(a) The tag <img src = “file name”> is used to insert pictures.
(b) The tag <img src = “file name”> is used to hyper link other files.
(c) Web sites are created by linking web pages.
(d) Web pages are created by linking websites.
An : (a) The tag <img src = “file name”> is used to insert pictures

(c) Web sites are created by linking web pages.
95). Which among the following can be used to display web pages?
a. Mozilla fire fox
b. Evins document viewer
c. Google chrome
d. gedit text editor
Answer
a.

Mozilla fire fox
c. Google chrome

96).Choose from the following, the two statements which are true.
a. The opening tag of a web page is <html> and the closing tag is </html> .
b. The expanded form of html is Hyper Terminal Markup Language .
c. The tag <title> is used to give title to the web page.
d. The tag <marquee> is used to include pictures in a web page.
Answer: a. The opening tag of a web page is <html> and the closing tag is </html> .
c. The tag <title> is used to give title to the web page.
97).Among the following statements only two are true. Find them out.
a) Using the tag <p>, a new paragraph can be started in a web page.
b)Using the text editor Mozilla Fire Fox, web pages can be created.
c)The tag <img src> is used to insert pictures in a web page
d)The tag <body bg colour = “blue” > can be used to get blue colour to a web page.
Answer : a)Using the tag <p>, a new paragraph can be started in a web page.
c)The tag <img src> is used to insert pictures in a web page
98).Which among the following HTML tags are correct?
a) <body background color=”red”>
b) <body bgcolor=”red”>
c) <font colour=”red”> GHSS Wandoor </font>
d) <font color=”red”> GHSS Wandoor </font>
Answer: b) <body bgcolor=”red”>
d) <font color=”red”> GHSS Wandoor </font>

99).Which among the following tags can be used to display a word in red colour with

underline in a web page?
a. <font colour=red>
b. <u>

c. <font color=red>
d. <i>
Answer
c. <font color=red>
b. <u>
100).Which among the following are true in the case of web pages?
a. The opening tag of every web pages is <html> and the closing tag is </html> .
b. The opening tag of every web page is <title> and the closing tag is </title> .
c. Images and videos can be included in a web page.
d. The tag </head> is used to name a web page.
Answer
a. The opening tag of every web pages is <html> and the closing tag is </html>
c. Images and videos can be included in a web page.
101). Source code of a web page is given below. Which among the four options are true

about this source code?

<html>
<body bgcolor=yellow>
<font size=6 color=red face = sans>WELCOME<br>
FRIENDS</font></body>
</html>
a. Font colour of the WELCOME is yellow.
b. The background colour of the page is yellow.
c. The background colour of the page is red.
d. The words WELCOME and FRIENDS are displayed in two lines.
Answer :

b. The background colour of the page is yellow.
d. The words WELCOME and FRIENDS are displayed in two
lines.
102). Source code of a web page is given below. Which among the following are the tags
used to make the sentence "Quality education is pupils right” blue in colour and move it
from right to left?

a) <font color =blue> <marquee> Quality education is pupils right </marquee></font>
b) <marquee direction = right, font color=blue> Quality education is pupils right
</marquee></font>
c) <font color =blue> <marquee direction = left>Quality education is pupils right

</marquee></font>
d) <marquee = right, font=blue> Quality education is pupils right </marquee></font>
Ans a)<font color =blue> <marquee> Quality education is pupils right </marquee></font>
c) <font color =blue> <marquee direction = left>Quality education is pupils right
</marquee></font>
103). Which among the following tags can be used to make the sentence INDIA IS
MY COUNTRY move right with font colour blue in a web page?
a)
b)
c)
d)
Ans:

<title >INDIA IS MY COUNTRY</title>
<font color=”blue”>
<b>ndiaindia is my country </b>
<marquee direction =right>INDIA IS MY COUNTRY </marquee>
b) <font color=”blue”>
d) <marquee direction =right >INDIA IS MY COUNTRY </marquee>

104). Which among the following are correct statements about Open Source Software.
a) We are free to run any programme for any purpose
b) We are not free to copy and re-distribute
c) We are free to copy and re-distribute
d) Source code is not available
Answer :
a) We are free to run any programme for any purpose
c)
We are free to copy and re-distribute
105).Which are the two ways to take Screen shot of Desktop?
a) System – Preference – Monitor
b) Press the Print Screen key on the Keyboard
c) Application → Accessories → Take Screen shot
d) Press right mouse button on the Desktop
Ans_
b) Press the Print Screen key on the Keyboard
c) Application → Accessories → Take Screen shot
(Same N0 105 is given to two qns. in Malayalam Qn paper)
106).We are familiar with Operating System and Application Software. Which of the

following statements are true?
a. Linux is an Application Software
b. Open Office is an Application Software
c. GIMP is not an Application Software
d. GNU/Linux is an Operating Software
Answer

:

b. Open Office is an Application Software
d. GNU/Linux is an Operating Software
107).Ganga and Riswana are preparing a list of Proprietary Software. Which of the
following can be included in the list ?
a)

Apple Mac OS X

b)

Microsoft Windows

c)

GNU/ Linux Ubuntu

d) Sun Solaris
Ans: a) Apple Mac OS X
b) Microsoft Windows
108). Choose the correct statements from the following

a. K Snapshot software is used for Video Recording
b. K Snapshot is used for capturing screen shots
c. gtk-recordMyDesktop software is used for recording the video of Desktop activities.
d. OpenShot is used for capturing screen shot.
Answer : b. K Snapshot is used for capturing screen shots
c. gtk-recordMyDesktop software is used for recording the video of Desktop
activities.
109).Which of the following activity is to be done to remove an item from the Panel ?

a) Right click on the panel
b) Right click on the item to remove
c) Choose the option 'add to panel'
d) Choose the option 'remove from panel'
Answer
b) Right click on the item to remove
d) Choose the option 'remove from panel'

Section 3
Four sets of statements are given below. Select the most
suitable statement from each set to prepare a short note on
the given topics.
2 Scores each
110).Make short notes on Transform tools in Gimp
Set A
a)Smudge Tool is used to resize the image, layer or the selected part of the image.
b)Scale Tool is used to resize the image, layer or the selected part of the image.
c) Measure Tool is used to resize the image, layer or the selected part of the image.
d) Blend Tool is used to resize the image, layer or the selected part of the image.
Ans: b)Scale Tool is used to resize the image, layer or the selected part of the image.
SET B

SET C

a) Rotate Tool is used to tilt an image, layer or the selected part of the image in a required
angle
b) Perspective Tool is used to tilt an image, layer or the selected part of the image in a
required angle
c)
Alignment Tool is used to tilt an image, layer or the selected part of the image in a
required angle
d) Paths Tool is used to tilt an image, layer or the selected part of the image in a required
angle
Ans: a) Rotate Tool is used to tilt an image, layer or the selected part of the image in a
required angle
a) Healing Tool is used to turn a picture either towards left or right.
b) Smudge Tool is used to turn a picture either towards left or right.
c) Dodge Tool is used to turn a picture either towards left or right.
d)
Flip Tool is used to turn a picture either towards left or right.

Ans: d) Flip Tool is used to turn a picture either towards left or right.
SET D
a) Clone Tool is used to avoid unnecessary parts of a picture
b) Rectangle Select Tool is used to avoid unnecessary parts of a picture
c) Free Select Tool is used to avoid unnecessary parts of a picture

d) Crop Tool is used to avoid unnecessary parts of a picture
Ans: d) Crop Tool is used to avoid unnecessary parts of a picture
111).Gimp Software
Set 1 a.Linus Tolvarts had an important role in designing Gimp software.
b. Richard Stallman had an important role in designing Gimp software.
c. Spencer Kimbal had an important role in designing Gimp software.
d. Jonathan Thomas had an important role in designing Gimp software.
Ans : c. Spencer Kimbal had an important role in designing Gimp software.
Set 2 a. An image or a part of an image can be included in GIMP
b. A presentation file can be included in GIMP
c. A Geogebra file can be included in GIMP
d. A spread sheet file can be included in GIMP
Ans :a. An image or a part of an image can be included in GIMP
Set 3(A)
a) One of the most important specialities of Gimp is that we can arrange slides one upon the
other
b) One of the most important specialities of Gimp is that we can include web pages in it
c) One of the most important specialities of Gimp is that we can arrange images and texts in
different layers
d) One of the most important specialities of Gimp is that we can search various time zones in
it.
1. Ans :c) One of the most important specialities of Gimp is that we can arrange images and
texts in different layers
Set 4
a)
b)
c)
d)

The original file format of an image prepared in Gimp is .png .
The original file format of an image prepared in Gimp is .odt
The original file format of an image prepared in Gimp is .xcf
The original file format of an image prepared in Gimp is .jpg

Ans :c) The original file format of an image prepared in Gimp is .xcf
112). Make shortnotes on Collage
Set 1
a. The most suitable software to prepare Collage is Open Office Spreadsheet.
b . The most suitable software to prepare Collage is Geogebra.
c . The most suitable software to prepare Collage is GIMP
d. The most suitable software to prepare Collage is Kstars
Ans : c. The most suitable software to prepare Collage is GIMP
Set 2
a. The tool used to select a particular portion of an image for a collage is Smudge tool.

b. The tool used to select a particular portion of an image for a collage is Flip tool.
c. The tool used to select a particular portion of an image for a collage is
Scale tool.
d. The tool used to select a particular portion of an image for a collage is Ellipse select
tool.
Ans : d. The tool used to select a particular portion of an image for a collage is
select tool.

Ellipse

Set 3
a Rotate tool helps to tilt an image or part of an image in a required angle.
b. Scale tool helps to tilt an image or part of an image in a required angle.
c. Flip tool helps to tilt an image or part of an image in a required angle.
d. Ellipse select tool helps to tilt an image or part of an image in a required angle.
Ans : a. Rotate tool helps to tilt an image or part of an image in a required angle.

Set 4

a. If pictures are included,the Layers in the collage can't be deleted.
b. If one layer is deleted, all the layers below it will vanish.
c. If one layer is deleted, all the layers above it will vanish.
d. Layers can be deleted .

Answer: d. Layers can be deleted .
113). Make short notes on Open Office Calc
SET : A
(a) It is a software to present something to an audience with the help of audio and visuals.
(b) It is a software to create and edit images.
(c) It is a software to consolidate and analyse data
(d) It is a software to prepare and display web pages.
Answer :
SET : B

- (c)It is a software to consolidate and analyse data

(a)The original file format of Open Office Spreadsheet is .odt
(b) The original file format of Open Office Spreadsheet is .odp
(c) The original file format of Open Office Spreadsheet is .ods
(d) The original file format of Open Office Spreadsheet is.odb
Answer - c) The original file format of Open Office Spreadsheet is .ods
SET : C
(a) The technique, Cell Freezing in OpenOffice spreadsheet is used to sort a table in descending
order.
(b) The technique, Cell Freezing in OpenOffice spreadsheet is used to merge cells
(c) The technique, Cell Freezing in OpenOffice spreadsheet is used to fix the title row
permanently
( d) The technique, Cell Freezing in OpenOffice spreadsheet is used to find out
average

Answer - (c) The technique, Cell Freezing in OpenOffice spreadsheet is used to fix the title
permanently

row

SET : D
(a) The function Average in OpenOffice spreadsheet is used to find out the square of a
number.
(b) The function Average in OpenOffice spreadsheet is used to find out the percentage
(c) The function COUNTIF in OpenOffice spreadsheet is used to find out the number of
cells that contain a specific value
(d) The function POWER in OpenOffice spreadsheet is used to find out the number of
cells that contain a specific value
1) Answer : (c) The function COUNTIF in OpenOffice spreadsheet is used to find out the
number of cells that contain a specific value.
114).Make short notes on Spreadsheet
SET: 1
a. OpenOffice Spreadsheet is a software that helps to prepare Maps.
b. OpenOffice Spreadsheet is a software that helps to prepare geometrical shapes.
c. OpenOffice Spreadsheet is a software that helps to record and edit videos.
d. OpenOffice Spreadsheet is a software that helps to consolidate data
Answer
d. Openoffice Spreadsheet is a software that helps to consolidate data
SET: 2
a. It is used to convert images to various formats.
b. It is used to analyse data.
c. It is used to edit videos.
d. It is used to prepare interactive geometrical shapes.
Answer
b. It is used to analyse data.
SET: 3
(a) The function Average in OpenOffice spreadsheet is used to find out the square of a number.
(b) The function Average in OpenOffice spreadsheet is used to find out the percentage
(c) The function COUNTIF in OpenOffice spreadsheet is used to find out the number of
cells that contain a specific value
(d) The function POWER in OpenOffice spreadsheet is used to find out the
number of cells that contain a specific value

Answer :
(c) The function COUNTIF in OpenOffice spreadsheet is used to find out the
number of cells that contain a specific value

SET: 4
a. ROUND function in this software is used to arrange data in ascending or descending order
b. ROUND function in this software is used to specify the required number of decimal places in a
decimal number.
c. POWER function in this software is used to find out the largest number in a table.
d. POWER function in this software is used to find out the smallest number in a table .
Answer
b. ROUND function in this software is used to specify the required number of decimal
places in a decimal number.
115). Prepare short note on the steps to insert Hyper link in Open Office presentation
SET - 1
1)

a. Select the Text → Format → Hyperlink
b. Select the Text →Insert → Hyperlink
c. Select the Text → Tools → Hyperlink
d. Select the Text → File → Hyperlink

Answer : b Select the Text →Insert → Hyperlink
SET - 2

a. Internet → path → Search for file
b. Document → Path → Open file
c. Target → Path → Open file
d. Hyperlink → Open file → Path

Answer : b. Document → Path → Open file
SET - 3
3)
a. Select the file
b. Copy the file
c. Click on Hyperlink
d. Click on Path
Answer : a. Select the file
SET - 4
4)

a. Edit- -Apply . Close the Hyperlink window.
b. Open-Apply. Close the Hyperlink window.
c. Add-Apply. Close the Hyperlink window.
d. Apply-OK. Close the Hyperlink window.

Answer : b. Open-Apply. Close the Hyperlink window.

116).Prepare short note on the Preparation of Project report using Office package.
SET 1
a) Tables for Data collection can be prepared in GIMP
b) Tables for Data collection can be prepared in Geogebra.
c) Tables for Data collection can be prepared in Calc
d) Tables for Data collection can be prepared in Impress.
Answer (c) Tables for Data collection can be prepared in Calc
SET 2
a) Open Office Writer can be used to prepare the project report in various Languages.
b) Geogebra can be used to prepare the project report in various Languages.
c)GIMP can be used to prepare the project report in various Languages.
d) Open office Calc can be used to prepare the project report in various Languages.

Answer (a) Open Office Writer can be used to prepare the project report in various Languages.
SET 3
a) The technique Auto Formatting in open office calc can be used to make the report
impressive.
b) The technique Styles and Formatting in open office Writer can be used to make the report
impressive.
c) The technique Conditional Formatting in open office Writer can be used to make the
report impressive.
d) The technique Conditional Formatting in open office Impress can be used to make the
report impressive.
Answer (a)The technique Styles and Formatting in open office Writer can be used to make the
report impressive.

SET 4
a) Video Presentation cannot be included in Open Office Calc
b) Video Presentation cannot be included in Open Office Writer
c)Audio Presentation is not possible in Open Office Presentation
d) Audio Presentation is possible in Open Office Presentation

Answer (d) Audio Presentation is possible in Open Office Presentation

117. Geogebra
SET 1
a. GeoGebra is an educational software used to find out Time Zones.
b. GeoGebra is an educational software used to draw Geometrical shapes.
c. GeoGebra is a software used to record videos.
d. GeoGebra is a software used to make changes in sound files.
Answer : b. GeoGebra is an educational software used to draw Geometrical shapes.
SET 2
a. It helps to edit videos.
b. It helps to consolidate and analyse data.
c. It helps to convert images into different formats.
d. It helps to observe the properties of geometrical constructions.
Answer : d. It helps to observe the properties of geometrical constructions.
SET 3
a. Slider is a tool which helps to control the length of a line segments and angles .
b. Slider is a tool which helps to create and analyse structure of elements.
c. Slider is a tool which helps to get a separate list of particular data from a table.
d. Slider is a tool which helps to arrange images one upon the other in transparent layers.
Answer :
angles

a. Slider is a tool which helps to control the length of a line segments and

SET 4
a. Round function can be used to specify the required number of decimal places in a decimal
number.
b. Dilation tool can be used to enlarge a figure.
c. Translation tool can be used to edit videos and make them attractive.
d. Scale tool can be used to resize images.
Answer : b. Dilation tool can be used to enlarge a figure.

118). Dilation in Geogebra
SET 1
a) Dilation is a tool in the software GeoGebra
b) Dilation is a tool in the software Open Office Spreadsheet

c) Dilation is a tool in the software in GIMP image editor
d) Dilation is a tool in the software in Open office Presentation
Answer : (b) Dilation is a tool in the software GeoGebra
SET 2
(a) It is used to enlarge a shape based on the distance from a given point.
(b) It is used to move a shape based on the distance from a given point.
(c) It is used to rotate a shape based in a given angle.
(d) It is used to flip a shape based in a given angle.

SET 3

Answer : (a) It is used to enlarge a shape based on the distance from a given point.
(a) We can assign the size of angle in which it should be rotated.
(b) We can assign the direction in which it should be moved.
(c) We can assign how much it should be enlarged.
(d) We can assign the size of angle in which it should be flipped. .
Answer :(c) We can assign how much it should be enlarged.

SET 4
(a) Dilation factor can be included in a check box.
(b) Dilation factor can't be controlled by other tools
© Dilation factor can be controlled by a slider.
(d) Dilation factor can be controlled by trace tool.
Answer :(c) Dilation factor can be controlled by a slider.
119) Tools in Geogebra

SET 1
(A) Slider tool in GeoGebra is used to control the length of line segments in geometrical
constructions.
(B) Slider tool in GeoGebra is used to measure length of line segments in geometrical
constructions.
(C) Slider tool in GeoGebra is used to change colour of line segments in geometrical
constructions.
(D) Slider tool in GeoGebra is used to measure width of line segments in geometrical
constructions.
An: (A) Slider tool in GeoGebra is used to control the length of line segments in geometrical
constructions.
SET 2

(A) Polygon tool is used to construct regular polygons.
(B) Polygon tool is used to construct polygons.
(C) Polygon tool is used to measure the angles of regular polygons.
(D) Polygon tool is used to measure the angles of polygons.
An: (B)Polygon tool is used to construct polygons.
SET 3
(A) Check box Tool is used to hide or show images or shapes when it is necessary.
(B) Check box Tool is used to resize an image .
(C) Check box Tool is used to change the opacity of colour of an image.
(D) Check box Tool is used to move an image.
A: (A) Check box Tool is used to hide or show images or shapes when it is necessary.
SET 4
(A) Distance or Length tool is used to find out perimeter of a polygon.
(B) Distance or Length tool is used to find out area of a regular polygon.
(C) Distance or Length tool is used to construct a regular polygon.
(D) Distance or Length tool is used to construct a polygon.
ഉതരം (A) Distance or Length tool is used to find out perimeter of a polygon.

120. Slider in Geogebra

SET 1
a. Slider is the tool used to enlarge a shape based on the distance from a given
point .
b. Slider is the tool used to construct a regular polygon.
c. Slider is the tool used to find out the sum of the interior angles of a polygon.
d. Slider is the tool used to control the length of a line, angle etc.
An : d. Slider is the tool used to control the length of a line, angle etc.
SET 2

a. Angle with given size is a tool with which the slider tool can be used.
b. Circle with centre through point is a tool with which the slider tool can be used.
c. Segment between two points is a tool with which the slider tool can be used.
d. Circle through three points is a tool with which the slider tool can be used.
An :a) Angle with given size is a tool with which the slider tool can be used.

SET 3

a.
is used to measure the area of a polygon

b.
is used to draw a polygon

c.

is used to draw a triangle
d.
is used to draw a perpendicular line
Answer : a.
SET 4

is used to measure the area of a polygon

a. A slider that controls the size of angles normally has the names a,b,c
b. A slider that controls the size of angles normally has the names α,β,γ
c. A slider that controls the size of angles normally has the names 1,2,3
d. A slider that controls the size of angles normally has the names ∅,π,∪

An :b. A slider that controls the size of angles normally has the names α,β,γ
121. Webpages

Set 1
(a) Python language is used to create web pages .
(b) wxGlade is used to create web pages .
(c) Programming language is used to create web pages .
(d html is used to create web pages .
Answer
(d )html is used to create web pages .
Set 2
(a)To display web pages Text Editor is used.
(b)To display web pages wxGlade is used.
(c)To display web pages Image Editor is used.
(d)To display web pages Web Browser is used.

Answer
(d )To display web pages Web Browser is used.
Set 3
(a) The tag <marquee direction=right> is used in web page to scroll sentence from right to left.
(b)The tag <p> is used to start a new paragraph.
(c) The tag <line/> is used to insert a new line.
(d)The tag <head> is used to insert text in title bar.
Answer
(b)The tag <p> is used to start a new paragraph.
Set 4
(a If the picture inserted in the html page will be displayed in the browser window,the saved html
file and the inserted picture should be in the same folder.
(b) Once saved, the html source page cannot be changed. So all works should be completed before
saving the web page.
(c)All web pages should be saved in home folder. Otherwise links will not work.
(d)It is possible to link images,audio files, movie files,pdf files to web pages.
Answer
(d)It is possible to link images,audio files, movie files,pdf files to web pages.
122.

,

Set 1
(a)In the source code of this web page the <title> tag is not given.
(b)In the source code of this web page the</title> tag is given.
(c)In the source code of this web page the </html> tag is given in the beginning.
(d)In the source code of this web page the <u> tag is given.
Answer
(a)In the source code of this web page the <title> tag is not given.
Set 2
(a) To give the font colour of the heading 2012 THE YEAR OF MATHEMATICS
<font color=”yellow”> tag is used

(b) To give the font colour of the heading 2012 THE YEAR OF MATHEMATICS
<font colour=”yellow”>tag is used
(c) To give the font colour of the heading 2012 THE YEAR OF MATHEMATICS
<fontcolor=”yellow”> tag is used
(d)To give the font colour of the heading 2012 THE YEAR OF MATHEMATICS
<fondcolor=”yellow”> tag is used

Answer
(a) To change the font colour of the heading 2012 THE YEAR OF
MATHEMATICS
<font color=”yellow”> tag is used.
Set 3
(a)To give background colour to this web page
(b) To give background colour to this web page
(c)To give background colour to this web page
(d) To give background colour to this web page

the tag <body bgcolour="green"> is used.
the tag <page bgcolor="green">is used.
the tag<body bgcolor="green"> is used.
the tag <page bgcolour="green">is used.

Answer
is used.

(c) To give background colour to this web page the tag<body bgcolor="green">

Set 4
(a) To insert the picture named ramanujan.jpg to this web page from the folder in which the file is
saved, the tag <insert image="ramanujan.jpg"> is used.
(b)To insert the picture named ramanujan.jpg to this web page from the folder in which it is saved,
the tag<a href ="ramanujan.jpg"> is used.
(c)To insert the picture named ramanujan.jpg to this web page from the folder in which it is saved,
the tag<embed src ="ramanujan.jpg"> is used.
(d)To insert the picture named ramanujan.jpg to this web page from the folder in which it is saved,
the tag <img src ="ramanujan.jpg"> is used.
Answer
(d) To insert the picture named ramanujan.jpg to this web page from the folder in
which it is saved, the tag <img src ="ramanujan.jpg"> is used.
123.Webpage
(a) It is not possible to edit a web page.
(b) It is not possible to include movies in a web page but can include pictures.
(c) Web pages are pages to exhibit and share information through digital media like
internet.
(d) There is no need of a particular software to watch web pages.

Answer
(c)Web pages are pages to exhibit and share information through digital media like
internet.
SET 2
(a)It is possible to link web pages to create websites.
(b)It is not not possible to link one web page to another. But picture files can be linked.
(c ) It is possible to link one web page to another. Whereas link can not be given to a file
in another format.
(d) It is not possible to save web pages and download pictures from web pages.
Answer

(a)It is possible to link web pages to create websites.

SET 3
(a)Web browsers are the software to edit web pages .
(b Web portals are the software to edit web pages .
(c)
Web sites are the software to edit web pages
(d) Web browsers are software to exhibit web pages.
Answer
(d) Web browsers are software to exhibit web pages
SET 4
(a)Web pages are saved in the file format .in
(b)Web pages are saved in the file format .gov.in
(c)Web pages are saved in the file format .com
(d)Web pages are saved in the file format .html
Answer

(d)Web pages are saved in the file format .html

124. HTML
SET 1

(a)Expanded form of HTML is Higher Mark up Language .
(b) Expanded form of HTML is Higher Make up Language.
(c) Expanded form of HTML is Hyper Text Mark up Language .
(d) Expanded form of HTML is Hyper text monitoring Language .
ANSWER
(c) Expanded form of HTML is Hyper Text Mark up Language.
SET 2
(a) All HTML pages start with </html> tag.
(b) All HTML pages start with <html> tag.
(c) All HTML pages start with <html/> tag.
(d)All HTML pages start with </html/> tag.
ANSWER
(c) All HTML pages start with <html> tag.
SET 3

(a) The HTML tag is used to start a new paragraph is <b> .
b) The HTML tag is used to start a new paragraph is <b>
c) The HTML tag is used to start a new paragraph is <p>
d) The HTML tag is used to start a new paragraph is <h1> .
ANSWER
SET4

(c) The HTML tag used to start a new paragraph is <p>
(a)The HTML
(b)The HTML
(c)The HTML
(d)The HTML

tag is used to change background colour is
tag is used to change background colour is
tag is used to change background colour is
tag is used to change background colour is

.
<page bgcolor> .
<body bgcolor>
<body bg color>
<page bgcolour>

Answer
(b) The HTML tag is used to change background colour is <body bgcolor>

125. Operating System Gnu- Linux
SET -1
a) No new user can be created in GNU/Linux other than the default one.
b) Any number of users can be created in GNU/Linux
c) Anew password of cannot be created for a new user.
d) There is no need of the password for the new user created in GNU/Linux .
Ans_ b) Any number of users can be created in GNU/Linux
SET -2
a) The first step to create a new user is to open the window in the order Application →
Education → Users and groups
b) The first step to create a new user is to open the window in the order System →
Preferences → Users and groups
c) The first step to create a new user is to open the window in the order Application→
Accessories →Users and groups
d) The first step to create a new user is to open the window in the order System
→Administration →Users and groups
Ans_ d)The first step to create a new user is to open the window in the order System
→Administration →Users and groups
SET -3
a) To create a new user , we should know the new password only.

b) To create a new user , we don't need any password.
c) To create a new user , we should know the administrative password
d) To create a new user , we don't need the administrative password
Ans_ c) To create a new user , we should know the administrative password
SET-4
a) The name of the new user should contain less than six letters.
b) The name of the new user should not contain numbers
c) Any name can be given to the new user.
d) The name of the new user should contain more than six letters.
Ans:- c)Any name can be given to the new user.

126. Open Source Software

SET -1
a) Linus Benedict Torvalds is the founder of Free software Foundation.
b) Richard Mathew Stallman is the founder of Free software Foundation.
c) Spencer Kimpel is the founder of Free software Foundation.
d) Tim bernerse Lee is the founder of Free software Foundation.
Ans:- b) Richard Mathew Stallman is the founder of Free software Foundation.
SET -2
a) We can make changes in a proprietary software.
b) We have no right to make changes in an open source software.
c) We have the right to improve an open source software and redistribute it.
d) The buyers of proprietary software have control over the software.
Ans:- c) We have the right to improve an open source software and redistribute it.
SET-3
a) We have the freedom to take copies of an open source software and re-distribute them.
b) We have the freedom to take copies of an open source software but not to re-distribute
them.

c)

Open source software can be bought paying money and then be used independently.

d) Open source operating system is available but no Open source application software is
available
Ans:- a) We have the freedom to take copies of an open source software and re-distribute
them.
SET-4
a) Sun Solaris, Open b.s.d., GNU/Linux etc are Open source software.
b) Windows, Mac etc are Open source software.
c) Yahoo, google etc are Open source software.
d) Internet Explorer, Mozilla etc. are Open source software.
Ans:- a) Sun Solaris, Open b.s.d., GNU/Linux etc are Open source software.

127.Gnu-Linux Operating System
SET -1
a)GNU/ Linux is an open source and free of cost Operating System .
b) GNU/ Linux , Open BSD,Sun Solaris etc are the available open source Operating
system
c)Linux is an application in which every software can be worked.
d)Linux is an Operating system available only through Internet.
Ans:- a) GNU/ Linux is an open source and free of cost Operating System .
SET പ് -2
a)The Kernel of GNU/ Linux Operating system was developed by Richard Stallman.
b)The Kernel of GNU/ Linux Operating system was developed by Linus Tolvarts.
c)The Kernel of GNU/ Linux Operating system was developed by Jonathan Thomas.
d)The Kernel of GNU/ Linux Operating system was developed by Linus Tolvarts and
Richard Stallman .
Ans:b) The Kernel of GNU/ Linux Operating system was developed by Linus Tolvarts.
SET -3
a)Solaris created by Sun Micro system is the basis of GNU/ Linux Operating system .
b)Unix is the basis of GNU/ Linux Operating system
c)GNU/ Linux Operating system was made up of the parts of GNU project and the

Kernel developed by Linus Tolvarts
d)GNU/ Linux Operating system is a project developed by Oracle corporation and Sun
Micro system.
Ans:c)GNU/ Linux Operating system was made up of the parts of GNU project and the Kernel
developed by Linus Tolvarts
SET -4
a)The marketing right of GNU/Linux is with Linus Torvalts. No others can market it.
b)The users are free to copy and redistribute the GNU/Linux Open source Operating .
c)The marketing right of GNU/Linux is with the Corporation of Oracle. No others can
market it.
d)The marketing right of GNU/Linux is with Richard Stallman. No others can market it.
Ans:b)The users are free to copy and redistribute the GNU/Linux Open source Operating .

